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A. Crop Zoning System of Bangladesh 

 

1. Background: 

Agricultural zonation in Bangladesh began in the mid-1980s with the launch of a landmark 

study titled “Land Resources Appraisal of Bangladesh for Agricultural Development”, 

initiated by the Government of Bangladesh with support from UNDP and FAO. Conducted 

between 1984 and 1988, this study resulted in the creation of the Agro-Ecological Zone 

(AEZ) database, which compiled Land Resources Inventory (LRI) data using reconnaissance 

soil surveys carried out from 1963 to 1975 [UNDP-FAO 1988]. The AEZ database laid the 

foundation for rational agricultural land use and was instrumental in formulating a national 

plan to produce 20 million metric tons of food grain by 1990. 

Between 1996 and 2001, under the project titled “Utilization of Agro-Ecological Zones 

(AEZ) Database and Installation of GIS for Agricultural Development” (AEZ/GIS), 

Bangladesh Agricultural Research Council (BARC) digitized the AEZ maps (scale 1:250,000) 

and upgraded the database with GIS capabilities. The project, funded by UNDP and technically 

supported by FAO, aimed to establish a GIS-based land resources system to enable rational 

and data-driven agricultural planning. A key innovation of the project was the integration of 

crop production potential assessment, using FAO’s concept of Length of Growing Period 

(LGP) zones, which correlate rainfall and temperature patterns with crop growth periods. 

Combined with soil and crop requirement data, this model supports evaluation of potential crop 

productivity at the national scale. 

In 2010, BARC formally launched crop suitability and zoning initiatives using the AEZ 

database, following a directive from the Ministry of Agriculture’s Annual Development 

Program. This work involved land suitability assessment and zoning for 17 major crops, using 

national-level AEZ data [S.G. Hussain; M.K.A. Chowdhury; and M.A.H. Chowdhury, 2012]. 

Alongside the national database, BARC also developed a GIS-based Upazila Land Resources 

Database during the AEZ/GIS project, utilizing data from Upazila Nirdeshika prepared by 

Soil Resource Development Institute (SRDI) through soil surveys. This semi-detailed database, 

based on digitized soil and landform maps at a scale of 1:50,000 for 459 upazilas, was designed 

for local-level agricultural planning. 

Recognizing its potential, a pilot crop zoning study was conducted between 2011 and 2014 

across 11 upazilas under a SPGR sub-project of NATP Phase-I. This study aimed to optimize 

agricultural land use through GIS-based analysis, and led to the development of an offline 

decision-support tool: the Crop Suitability Assessment Model (CSAM). The pilot 

successfully demonstrated how GIS and local land data could identify optimal crops and 

cropping patterns for specific regions. 

Building on these successes, BARC, with financial support from the Krishi Gobeshona 

Foundation (KGF), initiated the establishment of Crop Zoning System of Bangladesh. The 

system is based on an advanced methodological framework (see Figure 1) that integrates GIS, 

GPS, and RS technologies for data processing and output generation. 
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2. Crop Zoning System: 

The Bangladesh Agricultural Research Council is implementing the Crop Zoning System 

with the objective of formulating sustainable agricultural production plans to effectively 

address the current and emerging challenges facing the agriculture sector in Bangladesh. The 

Crop Zoning System of Bangladesh comprises four core components that collectively 

support data-driven decision-making in agriculture. These are, Crop Zoning Information 

System (CZIS), Khamari Mobile App, Crop Zoning Dashboard, and Agri-Advisory Portal.  

The system integrates soil and land data from the SRDI and climate data from the 

Bangladesh Meteorological Department (BMD). These datasets are used for comprehensive 

crop suitability assessments and informed zoning decisions. In addition, the system 

incorporates economic profitability analysis of different crops and cropping patterns, based 

on primary data collected through Focus Group Discussions (FGDs) at the upazila level. 

This ensures that both agronomic and economic factors are considered in recommending 

optimal land use. The crop varietal information and their management practices collected from 

National Agricultural Research System (NARS) institutes are also part of the system. 

The Institute of Water Modeling (IWM) has partnered in the development of the system, 

particularly contributing to the GIS-based architecture and application development 

components. The entire system is securely hosted on the National Data Centre cloud and is 

publicly accessible through the official domain, http://cropzoning.gov.bd. 

Crop zoning supports optimization of input use, resource conservation, and environmental 

risk reduction, making it a vital policy tool for Bangladesh in addressing challenges like 

population pressure, declining arable land, yield gaps, and climate change. It enables data-

driven land use planning, enhances agricultural productivity, and provides farmers with 

location-specific guidance on suitable crops, helping increase both food production and farm 

income. Furthermore, the system includes fertilizer recommendations based on local soil 

fertility conditions to promote balanced fertilization and higher yields. 

To date, BARC has completed crop suitability assessment, zoning, and fertilizer recommendation 

for 76 crops across 458 of Bangladesh's 495 upazilas. 

3. Institutional Framework: 

BARC serves as the lead agency, coordinating and implementing crop zoning activities. The 

SRDI and the IWM are strategic partners, providing expertise in the field of land and soil, and 

GIS application development, respectively. Key stakeholders include: 

• Department of Agricultural Extension (DAE) 

• Bangladesh Agricultural Research Institute (BARI) 

• Bangladesh Rice Research Institute (BRRI) 

• Bangladesh Institute of Nuclear Agriculture (BINA) 

• Bangladesh Wheat and Maize Research Institute (BWMRI) 

These institutions act as Focal Points, ensuring collaboration, information sharing, and 

coordinated efforts for the development of a robust crop zoning system across Bangladesh. 
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Fig. 1. Conceptual Framework and Processes of Crop Suitability Assessment 
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4. Objectives of Crop Zoning: 

The main objective of the Crop Zoning System is to support the Government of Bangladesh’s 

strategy to promote more efficient, climate-resilient, and sustainable agricultural 

production systems that contribute to the country’s food and nutritional security. 

More specifically, the system aims to: 

• Support agricultural policy and planning by providing reliable crop zoning 

information to policymakers and planners, enabling the development of farm-friendly 

policies that sustain an economically viable agriculture sector, while conserving 

productive farmland for both present and future generations. 

• Enhance access to localized agricultural information for farmers and other 

stakeholders by facilitating timely and accurate guidance on suitable crops, fertilizer 

recommendations, and other critical factors that contribute to higher productivity and 

improved farm income. 

• Promote awareness and adoption of the crop zoning system through capacity building 

and outreach, enabling farmers, extension personnel, and policymakers to understand 

and utilize zoning information effectively as they transition toward a more sustainable 

and resource-efficient agricultural system. 

5. Data for Crop Zoning System: 

• Upazila Land and Soil Data - Land and Soil Properties (Physical and Chemical), Soil 

Nutrient Status, and Soil & Landform Map (Upazila Nirdeshika) (SRDI); 

• Weather Data - Temperature, Rainfall, Humidity, Sunshine, Wind Speed, Cloud Cover 

(BMD); 

• Upazila Land and Soil Factor Maps - Land Type, Land Relief, Soil Texture, Soil 

Moisture, Soil Consistency, Soil Drainage, Water Recession, Soil pH, Soil Salinity 

(BARC);  

• Upazila Agrometeorological Maps - Pre-kharif, Kharif & Rabi Growing Period, Cool 

and Extreme Temperature Region (BARC); 

• Upazila Administrative Map – Upazila, Union & Mouza boundary (BARC, SoB, BBS 

Small Area Atlas); 

• Admin Unit Name and Geocode – Division, District, Upazila, Union, Mouza, 

Pourashava, Ward Name and Geocode (BBS, Govt. Portal); 

• Agricultural Data – Crop Production Technology, Crop Variety with Duration, Yield 

and Special Characteristics (NARS); 

• Elevation data – Digital Elevation Model (DEM) (SRTM); 
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• Land Use Map – Upazila Land Cover/Land Use Map (Agriculture and Non-Agriculture 

Area) (FD, Satellite imagery-BARC); 

• Crop Profitability Data – Economic Indicators for Measuring Profitability of Crops 

(Field survey-BARC); 

• Crop Suitability Requirement Data – Crop Requirements Data with Reference to Land, 

Soil, Climate Conditions (BARC); 

• Crop Suitability Rating – Crop Yield Limitation Rating in Relation to Land, Soil, and 

Climatic Factors. 

6. Crop Zoning System Component: 

All components of the Crop Zoning System have been developed using robust, open-source 

GIS and web technologies, ensuring scalability, flexibility, and sustainability. Key tools 

include: 

• Database & Backend: PostgreSQL, PHP (Laravel Framework) 

• Frontend: JavaScript, Vue.js, jQuery, Bootstrap 

• GIS Tools: OpenLayers, GeoServer 

• Server & OS: Nginx, Ubuntu 

• Mobile Platforms: Android Native, iOS 

This integrated technological ecosystem enables seamless access, analysis, and dissemination 

of crop zoning information across platforms and user groups. 

a. Crop Zoning Information System (CZIS) 

A centralized, GIS-based analytical platform that serves as the backbone of the crop zoning 

system. CZIS enables: 

• Data management: Entry, update, and storage of geospatial and attribute data. 

• Crop suitability assessment: Application of suitability rules and limitation ratings 

based on soil, climate, and economic parameters. 

• Map management and visualization: Interactive GIS-based tools for viewing spatial 

patterns. 

• Output generation: Automated crop zoning maps and analytical reports for planning 

and decision-making. 

This component supports spatial analysis and land evaluation critical for zoning decisions at 

various administrative levels. 
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b. Crop Zoning Dashboard 

A real-time decision-support interface tailored for policymakers, extension workers, 

researchers, and agricultural planners. The Dashboard provides: 

• Quick access to zoning data for agricultural planning and development. 

• Interactive visualizations including maps, graphs, and charts. 

• Scenario analysis tools for understanding the impacts of crop choices, resource 

allocation, and nutrient variability. 

This tool facilitates data-driven policymaking and monitoring of agricultural trends across 

regions. 

c. Khamari Mobile App 

A user-centric mobile application developed to deliver localized agricultural advisory 

services directly to farmers in the field. Key features of the Khamari App include: 

• Crop suitability recommendations based on land and soil characteristics. 

• Fertilizer guidelines customized to soil nutrient status and crop needs. 

• Information on agricultural technologies, crop varieties, crop management, and 

nutrient management. 

• User-friendly interface in Bengali, ensuring accessibility for mostly non-literate or 

semi-literate farmers. 

By empowering farmers to make informed decisions, the app contributes to optimized crop 

selection, improved yield, and sustainable soil management. 

d. Agri-advisory Portal 

A comprehensive, web-based platform for disseminating agricultural guidance and 

knowledge. The Agri-Advisory Portal serves: 

• Farmers, extension agents, and agricultural professionals, with content available in 

both Bangla and English. 

• Dynamic crop recommendations based on zoning and climate data. 

• Content management and expert advisory systems, enabling timely delivery of 

validated agricultural information. 

• Knowledge databases on best practices in crop production, soil health, pest 

management, and climate resilience. 

This portal acts as a bridge between research, extension, and farming communities, fostering 

informed agricultural development. 
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7. Benefits and Expected Outcomes of Crop Zoning: 

The Crop Zoning System identifies the potential of different areas; across regions or the entire 

country; for cultivating specific crops that maximize economic returns. When recommended 

crops are cultivated in suitable areas and the limiting factors (e.g., nutrient imbalance, soil pH) 

are addressed, farmers can achieve significantly improved yields and profitability. The system 

brings wide-ranging benefits, summarized as follows: 

1. Strategic Land Use Planning 

• Provides a robust framework for agricultural land use planning, ensuring a profitable 

and sustainable production system aligned with both short and long-term development 

goals. 

• Helps identify and preserve high-potential agricultural land, reducing the risk of 

conversion to non-agricultural uses. 

2. Resource Optimization 

• Promotes efficient utilization of land and water resources, integrating social, 

economic, and environmental considerations into sustainable agricultural development. 

• Enables lower production costs by guiding farmers to cultivate crops in areas naturally 

suited to them, avoiding high input costs in marginal lands. 

3. Yield Maximization 

• Narrows the gap between potential and actual crop yields by guiding farmers to 

cultivate recommended crops under optimal conditions. 

• Facilitates maximum yield potential through alignment of crop selection with land 

suitability parameters. 

4. Crop Diversification and Soil Health 

• Supports crop diversification by identifying areas where multiple crops can be grown, 

improving soil fertility and overall farm resilience. 

• Encourages year-round crop cultivation, including high-value crops such as vegetables, 

spices, flowers, and selected fruits. 

5. Market-Linked Sustainable Production 

• Lays the foundation for zoning-based agricultural production systems, linked to 

market demand and supply chains, supporting commercial agriculture and value chain 

development. 

• Promotes the growth of agro-based industries and agro-processing enterprises, 

creating employment opportunities and ensuring fair prices for farmers. 
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6. Climate-Responsive and Landscape-Based Farming 

• Facilitates climate-resilient agriculture by recommending crops suited to agro-

ecological and climatic zones. 

• Assists in identifying suitable lands for cultivation in hilly regions based on slope and 

landscape stability, helping mitigate land degradation. 

7. Urban and Peri-Urban Agriculture 

• Identifies areas for peri-urban agriculture, supporting the emerging demand for 

localized food systems in growing urban centers. 

8. Research and Innovation 

• Provides a scientific basis for initiating research programs focused on evaluating 

potential crop productivity, land suitability, and adaptive management practices. 

9. Enhanced Food and Nutritional Security 

• Contributes to increased cropping intensity, higher yields, diversification, and 

improved soil health—all of which underpin the country’s food and nutritional 

security goals. 

10. Agricultural and Economic Stability 

• Supports the preservation of agricultural land for farming, enhancing long-term 

stability and sustainability in rural economies. 

• Helps reduce land use conflicts by clearly defining farm and non-farm zones, promoting 

the co-location of support businesses such as suppliers, processors, and logistics 

services. 

8. Implementation and Sustainability: 

The Crop Zoning System provides strategic insights into the agronomic and economic 

potential of different regions across Bangladesh for cultivating specific crops. By identifying 

suitable crops for diverse agro-ecological zones, it enables informed decisions that can enhance 

agricultural productivity, efficiency, and profitability. 

However, the successful implementation and long-term sustainability of this system rely on 

several critical factors: 

1. Policy and Institutional Commitment 

• The adoption and mainstreaming of crop zoning outputs into land use planning, subsidy 

distribution, and agricultural development programs require strong policy backing. 

• Government leadership and sustained institutional support are essential to embed crop 

zoning into national and local planning processes. 
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2. Stakeholder Engagement and Collaboration 

• The system’s effectiveness hinges on active participation from research institutions, 

extension services, agri-inputs and financial services providers, and farmers. 

• Key stakeholder contributions include data sharing, field validation, capacity 

development, and dissemination of information to end-users. 

3. Role of Agricultural Scientists 

Agricultural scientists play a foundational role in generating the technological backbone 

required for effective crop zoning. Their responsibilities include: 

• Developing crop varieties and management practices suited to specific zones, 

including agro-ecologically constrained areas, to ensure sustainable productivity. 

• Creating and validating climate-resilient technologies that address seasonal variability 

and climate change impacts. 

• Making up-to-date agricultural technologies and innovations available through the 

crop zoning system, empowering farmers with informed choices. 

• Conducting on-farm trials to test potential crops in identified zones, providing empirical 

data to validate and refine zoning outputs. 

• Supplying detailed crop-growing requirements, including parameters such as soil type, 

landform, moisture, pH, salinity, planting time, and climatic conditions, to support 

accurate suitability assessments and limitation ratings. 

4. Role of Agricultural Extension Personnel 

As frontline facilitators, agricultural extension personnel are crucial to operationalizing crop 

zoning at the field level. Their key roles include: 

• Developing extension plans aligned with crop zoning data to support national production 

goals. 

• Disseminating information from the ‘Khamari’ mobile app to farmers, helping them 

understand and adopt crop recommendations by location. 

• Providing crop-specific advisory services, including information on profitable cropping 

patterns, recommended varieties, and production technologies thru the Khamari app. 

• Promoting balanced fertilization by sharing site-specific fertilizer recommendations 

via the Khamari app, a cornerstone of sustainable soil and crop health. 

• Organizing trainings for farmers and stakeholders on using the Khamari app and the 

adoption of crop zoning strategies. 

• Facilitating field demonstrations with farmers to promote adoption of potential crops, 

which can lead to crop selection for higher yields, agro-industrial development and 

the commercialization of agriculture. 
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5. Policy Support Requirements 

The long-term sustainability of the crop zoning system requires enabling policies and 

institutional support. Key policy needs include: 

• Institutionalize and implement crop zoning through national policies and local-level 

enforcement mechanisms. 

• Development of market access policies and supporting infrastructure that ensure fair 

and profitable pricing with a view to stimulate farmers to grow the crops recommended 

for their zones. 

• Implementation of training, motivation, and awareness programs to build farmer 

confidence and promote adoption. 

• Organization of national-level demonstration programs, including field days and 

farmer exchange visits, to showcase the benefits and impacts of zoning. 

• Use of mass media (both electronic and print) to raise public awareness and build 

confidence in the crop zoning approach. 

• Integration of crop zoning concepts into academic curricula, ensuring that future 

agricultural professionals are equipped with knowledge of spatial planning and resource 

optimization. 

9. Conclusions: 

The Crop Zoning System holds significant strategic importance for the Government of 

Bangladesh, particularly in light of critical national challenges such as rapid population 

growth, shrinking arable land, yield gaps, the need for efficient resource utilization, and 

the growing urgency to build resilience against climate change. Recognizing its relevance, 

the Government has incorporated crop zoning and land use planning into the National 

Agriculture Policy (2018) and the Smart Bangladesh Vision. Furthermore, the system aligns 

with the Sustainable Development Goals (SDGs), particularly those focused on sustainable 

agriculture, natural resource management, and ecosystem conservation. 

Once fully prepared, the crop zoning system will serve as a critical decision-support tool for 

policymakers, planners, and practitioners; enabling evidence-based agricultural strategies, 

optimized land use, and strengthened food and nutritional security. 

In conclusion, the crop zoning system represents a transformative approach for optimizing 

land use, increasing agricultural productivity, and building a resilient, sustainable food system 

in Bangladesh. Its success depends not only on the strength of the technical framework but also 

on the collective will and coordinated action of government, scientific communities, 

extension networks, and farmers alike. 
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B. Building Blocks of the Online Crop Zoning System 

The development of the online crop zoning system relies heavily on the integration of 

geospatial technologies—GIS (Geographic Information Systems), GPS (Global 

Positioning System), and RS (Remote Sensing)—for data processing and output generation. 

Both spatial and non-spatial datasets are core inputs for conducting comprehensive land 

suitability assessments and crop zoning studies. 

Key datasets include updated information on: 

• Land and soil characteristics 

• Climatic conditions 

• Socio-economic factors 

• Crop-specific requirements 

Additionally, spatial datasets such as: 

• Upazila soil and landform maps 

• Land-use/land-cover maps 

• Administrative maps featuring settlements, waterbodies, forests, rivers, and roads 

are essential for accurate zoning and analysis. 

Another critical component of the system involves: 

• Developing a methodological framework 

• Defining crop-specific rules based on soil, climate, and water requirements 

• Establishing suitability limitation ratings for each crop 

• Identifying appropriate algorithms and methods for processing data and calculating 

key indicators for land suitability 

At the core of the initiative is the development of a cloud-based GIS software, the Crop 

Zoning Information System (CZIS), which enables seamless data processing and output 

generation. For dissemination, several digital tools have been developed: 

• The Khamari Mobile App 

• The Crop Zoning Dashboard 

• An Agri-Advisory Portal 

These tools ensure that the output reaches relevant stakeholders, especially farmers, in an 

accessible and actionable format. 
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The study comprises six main components: 

1. Crop 

2. Land and Soil 

3. Socio-economic 

4. Agro-climatic 

5. Geographic Information System (GIS) 

6. Remote Sensing (RS) 

Each component involves critical tasks such as data gathering, verification, validation, and 

compilation, followed by the validation of outputs to ensure accuracy and relevance in 

decision-making. 
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1. Introduction 

The Crop Component plays a critical role in the crop zoning system by focusing on the 

collection and analysis of crop-specific biophysical information. The major functions under 

this component include: 

• Collation of biophysical requirements for each crop (e.g., temperature, rainfall, soil 

type); 

• Compilation of data on crop varieties, including their growth duration and yield 

potential; 

• Documentation and analysis of existing cropping patterns; 

• Formulation of crop-specific rules based on the soil, climate, and water requirements 

essential for optimal crop growth; 

• Development of suitability limitation ratings for each crop, identifying constraints 

that may impact successful cultivation in specific areas. 

This component ensures that the zoning system reflects realistic, science-based conditions for 

effective land use planning and crop selection. 

2. Objectives 

The objectives of crop component are: 

a) Select crops for crop zoning study and develop crop growth requirement based on land, 

soil and climatic for those selected crops;  

b) Formulate land and soil factor wise suitability limitation ratings for each crop and stress 

tolerant varieties upon which agro-edaphic suitability will be determined; 

c) Collate crop information in relation to yield and farming practices; 

d) Assist in validating crop suitability outputs. 

3. List of crops selected for crop zoning system 

 

Crop group Crop 
No. of 

crops 

Cereal Rice, Wheat, Maize, Kaon, Cheena, Barley 6 

Tuber & Root 

crops 

Potato, Sweet potato, Taro (Pani kochu), Eddo (Mukhi kochu) 4 

Sugar crops Sugarcane, Date palm, Palmyra palm 3 

Fibre crops Jute, Cotton, Kenaf, Mesta 4 

Oilseeds  Mustard, Ground nut, Linseed, Sesame, Soybean, Sunflower 6 

Pulses Lentil, Gram, Mung bean, Black gram (Mash), Grass pea 

(Khesari), Cowpea (Felon)  

6 

1. Crop Component 



 

14 | P a g e  
 

Crop group Crop 
No. of 

crops 

Spices & 

Condiments 

Chilli, Onion, Garlic, Ginger, Turmeric, Coriander, Betel leaf 7 

Vegetables Brinjal, Tomato, Cauliflower, Cabbage, Broccoli, Lady’s finger,  

Pointed gourd, Radish, Carrot, Country bean, Long yard bean,  

Spinach, Indian spinach, Stem amaranth, Red Amaranth, Bottle 

gourd, Pumpkin, Ridge gourd, Teasle gourd, Sponge gourd, Bitter 

gourd, Cucumber, Khira, Ash gourd, Snake gourd 

25 

Fruits Mango, Jackfruit, Banana, Papaya, Pineapple, Litchi, Guava, 

Jujube (Ber), Coconut, Golden apple, Lemon, Water melon, 

Musk melon, Malta 

14 

Beverage Tea 1 

Total  76 

 

 

4. Activities 

The main activities of the crop component are to gather information on crops, crop varieties, 

crop production technologies, cropping patterns, crop requirements i.e. soil, climate, water and 

validation of software generated output. In addition, selection of crop, crop inventory 

development, identification of crop varieties suitable for stress situation and formulation of 

crop growth requirement and agri-edaphic and agri-climatic suitability limitation ratings for 

each crop are also important activities of crop component. 

Activity 1: Development of crop inventory 

Activity 2: Selection of crops 

Activity 3: Collection of information on varietal characteristics of crops and    

varieties suitable for stress situation 

Activity 4: Development of crop growth requirements 

Activity 5: Agro-edaphic suitability limitation ratings for crops 

Activity 6: Agro-climatic suitability limitation ratings for crops  

Activity 7: Compilation of cropping pattern information 

Activity 8: Compilation of information for agri-advisory portal 

Activity 9: Validation of outputs 
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Processing and uploading crop data in crop zoning system 

Processing and uploading crop data in CZIS software: 

Step1: www.cropzoning.gov.bd 

Step2: Select 

Step3: 
Login with admin Id (email & password) 

Step4: Click on the pen mark (Data table) 

Step5: Click on the dropdown list 

 
To add or edit or delete any information regarding Division, district, upazila, 

union mouza, select the specific menu bar 

 
To add or edit or delete crop related information select Crop, Crop variety, Crop 

to land type mapping menu bar 

 
To add or edit or delete fertilizer related information select Fertilizer, Nutrient, 

Fertilizer application method, Yield (crop) info, Yield (tree) info menu bar 

 
To add or edit or delete crop profitability related information select Upazila crop 

profitability menu bar 

 

To add or edit or delete cropping pattern related information select Existing upazila 

cropping pattern (new), Profitable upazila cropping pattern, Fertilizer 

patterns menu bar 

 
To add or edit or delete soil group order related information select Upazila soil 

group order menu bar 

 
To add or edit or delete MHL-1 & MHL-2 ratio related information select Upazila 

wise MHL-1 & MHL-2 ratio menu bar 

 To add or edit or delete soil health related information select Soil health menu bar 

Outputs are displayed 

in Crop zoning 

dashboard, ‘Khamari 

mobile app’ & ‘Agri-

advisory portal’ 

http://www.cropzoning.gov.bd/
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Processing and uploading crop data in Agri-advisory portal: 

Step1: Agri-advisory portal data entry link: http://cropzoning.gov.bd:82/login 

Step2: Login with E-mail and password 

Step3: Select different menu to add or edit or delete Agri-advisory portal information. 

  

 

 

 

 

 

 

 

 

 

 

 

E-Mail Address 

Password 

Agri Portal (Entry/Update) 

→ Crop Variety Information 

→ Crop Production Technology 

→ Innovative Agriculture 

→ Seed Production 

→ Pest Management 

→ Post Harvest Management 

Miscellaneous 

→ Sliders 

→ Gallery 

→ FAQ 

→ Contact 

→ Check Feedback 

User Management 

→ User 

→ Role 
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1. Introduction 

Soil is one of the most vital life-supporting natural resources, as it underpins food production 

essential for human survival. A clear and comprehensive understanding of soil types and their 

spatial distribution is a critical prerequisite for developing effective local-level land use plans 

for agriculture, forestry, and other sectors. Systematic soil surveys provide the foundational 

information required for interpreting land use potential and planning for sustainable 

agricultural productivity. 

In the context of crop suitability assessment and crop zoning, land and soil resources—along 

with climatic data—form the core datasets. Among these, edaphic factors (physical and 

chemical soil properties) are especially influential on crop growth and performance. Nine 

edaphic factors generated by the Soil Resource Development Institute (SRDI) through its 

semi-detailed soil survey are utilized: 

• Land type 

• Land relief 

• Soil water recession 

• Soil drainage 

• Soil texture 

• Soil moisture 

• Soil Consistency 

• Soil pH 

• Soil salinity 

In addition, a set of soil chemical parameters is used for generating location-specific 

fertilizer recommendations, supporting precise nutrient management, including: 

• Organic Matter 

• Total Nitrogen 

• Phosphorus (Bray & Kurtz method) 

• Potassium 

• Sulphur 

• Zinc 

• Boron 

• Calcium 

• Magnesium 

2. Soil Component 
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• Copper 

• Iron 

• Manganese 

Data Processing and Validation 

Before integrating edaphic and soil chemical data into the system, validation is performed to 

identify and correct inconsistencies. Edaphic data are typically extracted from the map legends 

of the Upazila Nirdeshika, while soil chemical data are geospatially referenced based on 

their mapped locations. 

Validation is carried out using a combination of: 

• Established principles and rules of thumb 

• Logical interrelationships between soil physical and chemical characteristics 

Once validated, the data are coded using predefined classifications for each individual 

parameter. These coded datasets are then used to generate various thematic maps of edaphic 

factors. 

These maps are digitally produced using the Crop Zoning Information System (CZIS) 

software, and the corresponding fertilizer recommendations are disseminated to end-users 

via both the Khamari Mobile App and the Crop Zoning Dashboard. 

 

2. Objectives 

The objectives of soil component are: 

a) Integration of land and soil information for crop suitability assessment; 

b) Preprocessing of upazila land and soil properties data for preparing input file needed for 

crop suitability assessment; 

c) Preparation of policy recommendation for implementation of crop zoning in Bangladesh; 

d) Preparation of policy guidelines on the use and management of land and soil for sustainable 

agricultural development; 

e) Preparation of document on ‘Land, soil and water resources for sustainable agricultural 

production; 

f) Formulation of limitation ratings and crop growth requirement for crop suitability 

assessment and zoning; 

g) Determining fertilizer requirement of crops/ cropping patterns based on soil fertility status; 

h) Validation of outputs related to suitability assessment of crop. 
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4. Activities 

The collection of Upazila Nirdeshika from SRDI with soil and landform map, validation and 

coding of soil physical and chemical properties data, formulation of suitability limitation 

ratings for each crop are major activities of soil component. In addition, providing support to 

document preparation and validation of software generated output are important tasks for the 

group. The activities performed under soil component are enumerated elaborately in the 

following section: 

Activity 1: Selection of Upazila for crop zoning study 

Activity 2: Validation and coding, and compilation of land and soil properties data 

Activity 3: Validation and compilation of soil chemical data (analytical results of soil  

  samples collected from different location through semi-detailed soil survey at 

  upazila level) 

Activity 4: Framing suitability limitation rating for crops 

Activity 5: Validation of outputs  

Activity 6: Preparing document on recommendation for implementation of crop zoning, 

  soil management, etc. 
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Processing and uploading soil data in crop zoning system 

Processing and uploading land and soil edaphic data in CZIS: 

Step1: Collection of Upazila Nirdeshika from SRDI 

Step2: Validation, compilation and coding of land and soil properties data presented in Upazila 

Nnirdeshika 

Validation of edaphic data based on- 

 Relation between land type, drainage and water recession. 

 Relation between soil texture, consistency, residual soil moisture and organic matter. 

Step3: The coded data of 9 lands and soil factors are compiled and organized in an Excel file.  

upz_ 

code aez physio mu 

mu_

area 

nc_ 

area 

land

form 

land_ 

type 

lt_ 

area 

soil_ 

group 

soil_ 

group 

name 

sg_ 

area texture 

456122 28 31 1 645 37 3 1 541 2010 Tejgaon 444 4 

456122 28 31 1 0 0 3 1 0 233 Belabo 65 4 

456122 28 31 1 0 0 3 1 0 1930 Sayek 32 4 
 

consist

ency drainage reaction 

mois

ture salinity 

recessi

on relief c_area forest fallow edaphic_code 

2 1 2 2 1 1 1 444 0 0  

2 2 2 2 1 1 1 65 0 0  
2 2 2 1 1 1 1 32 0 0  

 

Step4: www.cropzoning.gov.bd 

Step5: Select 

Step6: Login with admin Id (email & password)  

Step7: Select  

Step8: Select ‘Suitability Rating’ option 

 

 

Continue 

http://www.cropzoning.gov.bd/
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Step9: Select ‘Soil Parameter Entry  

Step10: Select upazila        Select                      to see the parameters 

Select         to Add new information 

Select edit          option to edit information 

Show 

+ 

Show 

Add new 

Delete 

Edit 

Continue 
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Step11: Select Land type        and then         to add or edit or delete land and soil properties data 

Select Soil group          and then        to add or edit or delete land and soil properties data 

 

Step12: Select                 to save the data.     

Step13: → Analyze and generate Agro-edaphic map (Land type, soil texture, soil moisture map etc) 

→ Coded data used for preparing maps of individual land and soil factors. 

→ These map layers are used for agro-edaphic suitability assessment crop(s).   

 

 

 

 

 

 

 

 

 

 

 

 

 

Save 
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Processing and uploading upazila soil group order in CZIS: 

Step1: www.cropzoning.gov.bd 

Step2: Select 

Step3: Login with admin Id (email & password) 

Step4: Click on the pen mark (Data table) 

Step5: Click on the dropdown list 

Step6: Select Upazila Soil Group Order 

Step7: 

Click +Add New to add soil group order entry 

Step8: Click Save  

 

 

 

http://www.cropzoning.gov.bd/
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Processing and uploading MHL-1 & MHL-2 ratio in CZIS: 

Step1: www.cropzoning.gov.bd 

Step2: Select 

Step3: 
Login with admin Id (email & password) 

Step4: Click on the pen mark (Data table) 

Step5: Click on the dropdown list 

Step6: Select Upazila wise MHL-1 and MHL-2 Ratio 

Step 7: 
For Upazila wise MHL-1 and MHL-2 Ratio entry: 

MHL area: Total MHL2 area 

MHL1 Area: MHL1 Ratio division of 100 (MHL1 Ratio/100) 

MHL2 Area: MHL1 area Subtraction of MHL area (MHL1 area-MHL area)  

Continue 

http://www.cropzoning.gov.bd/
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Step8: 

Click +Add New to add Upazila wise MHL-1 and MHL-2 Ratio  

Step9: Click Save  

Step 10: 
In the soil group order entry, in case of land type-2, both Medium Highland-1 

and Medium Highland-2 must be entered. In the soil group order entry, in case 

of land type-2, both Medium Highland-1 and Medium Highland-2 have to be 

entered. In case of multiple soil groups, the soil group serial will start with 1,2,3 

in case of Medium Highland 1 and 1,2,3 in case of Medium Highland 2 and if 

there is only one soil group, it will be 1 in case of both. 
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Processing and uploading soil chemical data in Land use map: 

Step1: Collection of Upazila Nirdeshika from SRDI 

Step2: Validation, compilation and coding of soil chemical data presented in Upazila nirdeshika 

Validation of soil chemical data based on- 

Relation between parent material and soil pH 

Relation between soil pH, macronutrient and micronutrient availability 

Step3: These data include N, P, K, S, Zn, B, Ca, Mg, Fe, Cu, Mn, Soil reaction (pH), organic matter, 

and Soil salinity (EC) and organized in an Excel file. 

MU 

Smpl 

No. 

Soil 

Series Texture Landtype 

Soil 

group pH EC OM N 

P 

(O) P(B) K S Zn B Ca Mg Cu Fe Mn Upz_code 

1 7 Ramgati Loam MHL 1805 6.5 5.98 1.75 0.087 0 3.9 0.25 16.7 0.31 0.33 22.22 10.72 4.58 30.86 39.8 107857 

 
32 Ramgati Loam MHL 1805 5.1 5.34 1.48 0.074 0 4.1 0.3 36.9 0.67 0.04 19.6 11.98 6.86 34.7 44.43 107857 

 

Step4: 
Chemical test data provided by soil expert was joined with the digitized sample point layer using 

the 'Join' tool in ArcGIS. This join was based on a common field (e.g., sample No.). The joined 

attributes (e.g., pH, Nitrogen, Phosphorus) enabled spatial analysis of soil quality across upazila. 

Step5: Select Upazila          Soil sample location and keep open the layer         Select          icon  

Click on the soil sample location point to display the information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rangamati 

1805 
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1. Introduction 

The socio-economic component plays a pivotal role in the Crop Zoning, as it directly 

influences farmers’ decisions regarding the adoption of agricultural technologies. Recognizing 

that technology alone does not guarantee adoption, this component has been integrated to 

reflect the real-life decision-making processes of farmers, particularly in Bangladesh’s 

diverse rural context. 

In Bangladesh, crop selection by farmers is often driven not solely by agronomic suitability, 

but also by household consumption needs, market demand, and profitability. A farmer’s 

choice of crops and cropping patterns is thus significantly shaped by economic incentives, 

market accessibility, input affordability, and potential returns on investment. 

Incorporating these socio-economic realities into the crop zoning framework ensures that the 

recommended crops and cropping patterns are not only agro-ecologically viable but also 

economically attractive and practically adoptable. This alignment increases the likelihood 

of farmer adoption, ultimately contributing to the broader goals of increased agricultural 

productivity, income generation, and rural economic development. 

By factoring in market trends, profitability data, and farmers’ preferences, the Crop Zoning 

promotes the selection of profitable and sustainable cropping patterns, empowering farmers 

to make informed and beneficial choices tailored to both their environment and livelihood 

needs. 

 

2. Objectives 

The objective of socio-economic component is to collect data on crop production and analyze 

financial suitability of crop/cropping pattern providing options to the farmers in choosing right 

crop/cropping pattern. However, objectives of socio-economic component follow; 

a) Analyze profitability of crops/cropping pattern cultivated by the farmers; and 

b) Provide information on profitability of crops/cropping patterns supporting better decision 

making both at micro and macro-economic level.  

 

3. Activities 

The activities undertaken by socio-economic component are as follows: 

Activity 1: Formation of Socio-economic Expert Committee 

Activity 2: Develop methodology 

Activity 3: Develop questionnaire and checklist 

3. Socio-economic Component 
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Activity 4: Field testing of questionnaire 

Activity 5: Assist to develop data management software 

Activity 6: Selection of profitability indicators 

Activity 7: Develop guideline for enumerators (SSO & SO’s) 

Activity 8: Define terms used in questionnaire/ methodology 

Activity 9: Collect information related to cost and return info of different crops 

Activity 10: Edit, entry, compile and analyze socio-economic data 

 

Socio-economic data management, processing and uploading 

Step1: Collect socio-economic data through Focus group discussion from upazila level 

using structured questionnaire  

Step2: Login to Socio Economic Data Management Software (hosted in LAN) 

 

Step3: Entry socio-economic data into the SEDC software collected from upazila level 

Step4: Generate report of crop and cropping pattern profitability (GM, BCR) from SEDC 

software 

Step5: Cross-check output data and correct in SEDC software if there is any error/ 

anomalies found and generate final report for uploading 

Step6: www.cropzoning.gov.bd 

Step7: Select 

Step8: Login with admin Id (email & password) 

http://www.cropzoning.gov.bd/
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Step9: Click on the pen mark (Data table) 

Step10: 

Click on the dropdown list  

 

Step11: To add or edit or delete crop profitability related information select Upazila crop 

profitability menu bar  

Step12: To add or edit or delete cropping pattern related information select Existing 

upazila cropping pattern (new), Profitable upazila cropping pattern, 

Fertilizer patterns menu bar 

Step13: Output will be displayed in Khamari Mobile App, Agri-advisory Portal and Crop 

Zoning Dashboard 
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1. Introduction 

Agriculture is the main driving force of the economy of Bangladesh. This agriculture is highly 

dependent on climatic phenomena. Despite technological improvements such as improved crop 

varieties and irrigation systems, weather and climate are still key factors in agricultural 

productivity. Changes in temperature, erratic behavior of rainfall, temporal changes in cropping 

seasons, increasing frequency and intensity of weather-related extreme events including floods, 

droughts, cyclones and storm surges, salinity intrusion into inland water and soil are the major 

climate change related threats to agriculture. For ensuring optimal production of crops, it is 

necessary to rationally manage the lands and choose the most suitable crops considering the 

soil, topography, environment and climate. 

Zoning of climate provides a better know how to the farming community to grow their crops 

according to the agro-climatic potential of different regions for maximum harvests. The need 

for such analysis becomes more relevant when uncertainties related to climate variability and 

climate change dominate over the normal weather patterns. In crop zoning study, AEZ 

methodology for agro-climatic zoning is followed for crop suitability assessment. The agro-

climatic zoning is a quantification of the temperature and moisture regimes of Bangladesh, 

including the year to year variability. The moisture regime is quantified in terms of reference 

growing periods by using a water balance model (FAO/UNDP, 1988). The moisture growing 

period is the period during a year when precipitation exceeds half the potential 

evapotranspiration, plus a period required to evapotranspire an assumed 100 mm of water from 

soil storage for the kharif season and an assumed 250 mm for the rabi season. The thermal 

regimes are described in terms of duration of critical temperature periods in the rabi (winter) 

and pre-kharif (summer) season.  

2. Objectives 

The objectives of agro-climate component are as follows: 

a) Gathering, editing, formatting and compilation of weather data; 

b) Characterizing thermal and moisture regimes for crop suitability assessment; 

3. Agro-climatic Factors 

Moisture Regime Thermal Regime 

Pre-kharif transition period Cool Winter Temperature (≤ 15°C) 

Kharif Length of Growing period Hot Summer Temperature (≥ 40°C) 

Rabi Length of Growing period  

 

4. Activities 

Activity 1: Preparation of agro-climatic database 

Activity 2: Thermal regime analysis 

4. Agro-climate Component 
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Activity 3: Potential evapotranspiration (PET) calculation 

Activity 4: Characterization of moisture regimes 

5. Moisture and Thermal Regime Characteristics 

Pre-Kharif 

Transition 

Period 

This period is considered to start on the first date after end of February when 

precipitation first exceeds 0.5 PET (potential evapotranspiration). The period 

ends on the date from which precipitation continuously exceeds 0.5 PET (i.e. 

the beginning date of the Kharif growing period). Characterized by unreliable 

rainfall and providing only an intermittent supply of moisture for crop 

growing.  

Kharif 

Growing 

Period 

In this period moisture supply from rainfall plus soil storage is sufficient to 

support non-irrigated kharif crops. The period begins on the date from which 

precipitation continuously exceeds 0.5 PET and ends on the date when the 

combination of precipitation plus an assumed 100 mm of soil moisture storage 

after the rainy season falls below 0.5 PET.  

Rabi 

Growing 

Period 

When plants are dependent on 250 mm of stored soil moisture after 

precipitation falls below PET i.e. the period between the end of the humid 

period and the time when 250 mm of soil moisture have been exhausted by 

evapotranspiration. 

Cool 

Temperature 

No. of days in Rabi with minimum temperature less than 15 °C 

Extreme 

Summer 

Temperature 

No. of days maximum temperature exceeds 40 °C. The extremely high 

temperature usually occur in April-May, occasionally in early June. The 

significance is that it creates a very high PET demand which plant roots may 

not be able to satisfy, especially in kharif crops at the seedling stage.  
 

6. Data Source used in crop zoning activity 

• BMD has been operating 56 weather stations, from where point based data (rainfall, 

temp, RH etc.) have been collected for utilization in Forecasting and sectoral use.  

• These data are very important for farmers and farming communities.  

• As per earlier practice Climate Data base of BARC is having 34 BMD Stations data upto 

2019 with data gaps.  

• To overcome this situation and to upgrade the data base the following initiatives have 

been taken: 

a. Collection Global gridded rainfall data- Climate Hazards Group InfraRed 

Precipitation with Station data (CHIRPS), Climate Prediction Center (CPC) 

Morphing Technique (CMORPH), Precipitation Estimation from Remotely Sensed 

Information using Artificial Neural Networks- Climate Data Record (PERSIANN-

CDR); 

b. Collection of Point based observation data of BMD and ENACT data of BMD; 

c. BMD’s 56 point based data are extracted utilizing different softwares/ programmes 

and techniques; 

d. Compare the extracted data with observation to check the quality of data; 

e. Prepare a qualitative rainfall data base for 1981-2021 at all 56 locations; 

f. After refining the rainfall data of 56 locations have been prepared. 
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1. Introduction 

A Geographic Information System (GIS) is a powerful framework for gathering, managing, 

analyzing, and visualizing spatial data. Rooted in the science of geography, GIS integrates a 

variety of data types—both spatial and non-spatial—so long as they are tied to geographic 

locations. This technology provides critical support for evaluating land suitability and 

capability, estimating and predicting outcomes, interpreting patterns, and enhancing 

understanding of complex interactions between natural and human systems. Through spatial 

analysis, GIS enables informed decision-making by offering insights into historical, current, 

and future scenarios. 

In the context of crop zoning, GIS technology is employed to develop an online, GIS-based 

land suitability assessment and crop zoning system to support sustainable agricultural 

planning. This system facilitates rapid generation, synthesis, and analysis of data across 

various geographical areas and time frames, helping to evaluate the impacts of different land 

management practices. 

Sustainable agricultural production is closely tied to the judicious use of natural resources—

such as soil, water, climate, rainfall, and topography—and the adoption of context-appropriate 

technologies. Therefore, the systematic collection, updating, and analysis of relevant data 

using GIS forms the backbone of the Crop Zoning Project. The resulting outputs—such as 

crop suitability maps, thematic layers, and zonal recommendations—are used in decision 

support tools like the Crop Zoning Information System (CZIS), the Khamari Mobile App, 

and the Crop Zoning Dashboard, ultimately guiding stakeholders toward data-driven and 

sustainable land use decisions. 

2. Objectives 

The primary objective of the GIS component in the Crop Zoning Project is to gather, 

manage, update, and analyze geospatial data to support the development of a land 

suitability assessment and crop zoning system for Bangladesh. 

GIS technology is instrumental in the generation of thematic maps representing key agro-

edaphic (soil-related) and agro-climatic (climate-related) factors. These include variables 

such as landform, soil type, pH, salinity, organic matter content, rainfall, temperature, and 

growing period. By integrating these datasets, GIS enables the spatial analysis of crop 

requirements against land characteristics and climate variability, leading to the classification 

of land areas based on their suitability for different crops. 

The agro-edaphic and agro-climatic suitability assessments are executed through overlay 

analysis and spatial modeling using GIS, producing location-specific maps and suitability 

information. These outputs are essential for guiding crop selection, fertilizer 

recommendation, and broader agricultural planning at both local and national levels. 

5. GIS & RS Component 

GIS Component 
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4. Activities 

The activities undertaken by GIS component are as follows: 

Activity 1: Conversion of existing ArcInfo coverage files and projection transformation 

Activity 2: Creation of administrative, soil polygon (SoP) and soil sample location (SoL) 

map layers for newly established upazilas 

Activity 3: Scanning and georeferencing of upazila soil and landform maps 

Activity 4: Spatial adjustment for updating of existing upazila soil polygon (SoP) maps  

Activity 5: Digitization of upazila soil sample locations data 

Activity 6: Joining of soil chemical analysis data with upazila SoL map layers 

Activity 7: Preparation of map layers from SoB geodata 

Activity 8: Updating of administrative boundary (district, upazila, union and mouza) 

Activity 9: Field validation of land type 

Activity 10: Preparation of spatial interpolated upazila nutrient status map 

 

 

 

 

 

1. Introduction 

Remote sensing is the science of collecting information about objects or phenomena from a 

distance—typically using sensors mounted on satellites, aircraft, or drones—without direct 

physical contact. These sensors detect and record reflected or emitted energy, which is then 

analyzed to derive insights about an object’s physical characteristics, environmental 

interactions, and temporal changes. 

In the context of agriculture, remote sensing enables continuous and large-scale monitoring 

of crop health, land use, and productivity. Devices capture multispectral and hyperspectral 

imagery over time, allowing for the analysis of critical parameters such as vegetation indices, 

soil moisture, crop growth stages, and yield estimations. These insights help guide decision-

making for optimizing crop performance and land use. 

In the Crop Zoning System of Bangladesh, remote sensing plays an integral and strategic 

role in the development of the zoning system. It is primarily used to generate and update Land 

Use and Land Cover (LULC) maps, crop type maps, and a crop monitoring system. 

The most recent LULC maps derived from Earth Observation data enhance the accuracy of 

land suitability assessments by clearly identifying agricultural land areas, thereby confining 

suitability analysis to relevant zones. This significantly improves the reliability of outputs 

generated by the Crop Zoning Information System (CZIS). 

Moreover, satellite-based monitoring enables the detection of crop types, planting dates, 

growth progress, and overall crop health. This real-time data supports not only national-

RS Component 
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level planning and policymaking but also offers practical applications for farmers, 

agribusinesses, and agricultural advisory services. These datasets feed into various 

downstream systems such as agricultural subsidies, insurance, certification, and digital 

advisory platforms including the Khamari Mobile App. 

Thus, the remote sensing component is vital for providing accurate, timely, and location-

specific agricultural intelligence, supporting both field-level decisions and national strategies 

for sustainable agriculture in Bangladesh. 

2. Objectives 

The main objectives of remote sensing activity is to generate required LULC information and 

crop informatics by utilizing earth observation data for facilitating and contributing in 

developing crop zoning systems for Bangladesh. The major goals are as follows: 

a) Preparation of land use and land cover (LULC) map of Bangladesh 

b) Crop mapping for the whole country 

c) Develop a crop monitoring system 

4. Activities 

The main activities of remote sensing are preparation of recent land cover, and land use map 

from satellite acquired data (earth observation data) providing the country’s agricultural areas 

(agricultural mask). Further, the earth observation data within the agricultural mask areas are 

analyzed using machine learning techniques to identify the crops for crop mapping. Besides 

crop mapping, a crop monitoring system is developed based on spatiotemporal analysis within 

the different crop areas of the crop map. These activities are carried out progressively based on 

top-down and empirical approaches.  

 

The main activities of the remote sensing component are as follows.  

Activity 1: Designing and implementing strategies for remote sensing data processing 

Activity 2: Preparation of land cover and land use map 

Activity 3: Identification of orchard areas 

Activity 4: Developing statistical analytics for land use and land cover  change detection 

Activity 5: Crop mapping 

Activity 6: Crop monitoring 

Activity 7: Performing field validation 
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GIS & RS-Based Workflow for Crop Zoning 

ArcGIS Desktop version 10.8 is used for performing the GIS tasks. The workflow steps are 

discussed sequentially in the following section. 

Georeferencing the Soil and Landform Map 

High-resolution scans of upazila-level soil and landform maps were georeferenced using the 

administrative boundary of the upazila as the base layer. The 'Georeferencing' toolbar in 

ArcGIS was used for this task. Ground Control Points (GCPs) such as road intersections, pond 

edges, and railway crossings were selected to improve spatial accuracy. The transformation 

method typically used was '1st Order Polynomial (Affine)', ensuring the scanned maps align 

with other spatial datasets for precise geospatial analysis. 

Below are the steps involved in georeferencing the soil and landform map: 

1. Open ArcMap and load the upazila boundary shapefile. 

2. Go to Customize > Toolbars > Georeferencing to activate the Georeferencing toolbar. 

 

3. Click Add Data to add the scanned soil and landform map (raster image). 

4. On the Georeferencing toolbar, choose the raster layer from the dropdown. 

5. Click Georeferencing > Fit to Display to bring the raster into view. 

6. Click on the Add Control Points tool. 
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7. Click on a known point (e.g., road intersection) on the soil and landform map, then click 

the same point on the base layer (satellite imagery). 

8. Add 4–6 such Ground Control Points (GCPs) at well-

distributed locations. 

9. In the toolbar, go to Georeferencing > Update 

Georeferencing to save the transformation. 

10. Use 1st Order Polynomial (Affine) as the transformation 

method (set in the Georeferencing options). 

 

Land use data preparation 

Land use data was generated from recent Sentinel-2 satellite imagery. Preprocessing was 

performed using ArcGIS’s 'Composite Bands' tool for layer stacking, and 'Stretch' functions 

for image enhancement. Following this, non-agricultural features such as settlements, rivers, 

brickfields, and ponds were manually digitized using the 'Editor Toolbar' and 'Create Features' 

pane in ArcMap. This digitization was guided by visual interpretation of the imagery, 

distinguishing non-agricultural land from areas available for cropping. 

Following are the steps of preparing land use data: 

11. Download the recent year sentinel-2 satellite image of dry season (March-April) from 

Google earth engine platform or from the following website: 

https://browser.dataspace.copernicus.eu  

 

12. Add Sentinel-2 satellite image bands to ArcMap. 

13. Use Composite Bands (Data Management Tools > Raster > Raster Processing > 

Composite Bands) to stack the bands. 

14. Use Stretch in the Symbology tab for visual enhancement. 

15. From Arc Catalog create a new Polygon Shapefile 

16. Activate the Editor Toolbar (Customize > Toolbars > Editor). 

https://browser.dataspace.copernicus.eu/
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17. Click Start Editing and select the newly created polygon shapefile for digitizing. 

18. Open the Create Features pane (Editor Toolbar > Create Features). 

19. Digitize visible non-agricultural features (e.g., settlements, rivers, ponds, brickfields). 

 

 

20. Click Save Edits, then Stop Editing when digitizing is complete. 

 

Delineation of Agricultural land 

Agricultural land was derived by subtracting the digitized non-

agricultural features from the total upazila land area. This was 

done using the 'Erase' tool in ArcToolbox, which removes the 

non-agricultural polygons and retains the remaining 

agricultural areas for further analysis. 

The steps are given below:  

21. Open ArcToolbox > Analysis Tools > Overlay > Erase. 

22. Set: Input Features = Total upazila boundary, Erase Features = Non-agricultural layer, 

Output Feature Class = Agricultural land layer. 

23. Click OK to execute. The resulting layer represents agricultural land. 
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Digitizing Soil Boundary 

Within the agricultural land, soil boundaries from the soil and landform map were digitized 

using ArcGIS. The 'Editor Toolbar' was applied to trace and digitize each soil map unit. Each 

polygon was attributed with the corresponding soil unit code. This creates a spatial 

representation of different soil types within the agricultural land. 

The steps are given below: 

24. Add georeferenced soil and landform map. 

25. Add the Agriculture Land Polygon shapefile which was created by Erase tool. 

26. Start editing the agricultural land layer. 

27. Use Cut Polygons Tool to divide each soil map unit boundary manually. 

 

28. Assign the correct map unit code in the attribute table for each polygon. 

29. Save and stop editing when complete. 

Integration of Agricultural and Non-Agricultural Land Features  

The digitized agricultural soil polygons were merged with the non-agricultural features using 

the 'Update' tool available in ArcToolbox. This creates a single unified feature class that 

accurately represents all land uses and soil units, which is essential for comprehensive zoning 

and analysis. 

30. Open ArcToolbox > Analysis Tools > Overlay > Update. 

31. Set: Input Features = Agricultural soil layer, Update Features = 

Non-agricultural layer, Output Feature Class = Merged land 

use layer. 

32. Click OK to generate the integrated land use layer. 

 

 

Topology check 

A topology check was conducted using ArcGIS's 'Topology Rules' in a geodatabase feature 

dataset. The two primary rules applied were: 'Must Not Overlap' and 'Must Not Have Gaps'. 

These rules were defined in a topology layer and validated using the 'Error Inspector' tool, 

which flags errors like overlapping or missing polygons. Corrections were applied using the 

topology editing tools to ensure data integrity. 

The steps are given below: 

33. Create a new Feature Dataset in a file geodatabase with the desired projection. 

34. Import the integrated layer into this feature dataset.  

35. Right-click on the Feature dataset > New > Topology. 

36. Add the layer and set the rules: Must Not Overlap,  

Must Not Have Gaps. 
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37. Finish topology setup. 

38. Add the topology layer to the map. 

39. Open Error Inspector (from Topology Toolbar) to detect errors. 

40. Fix errors using the Editor Tool. 

 

Extract the Location of Soil Sample Collection 

Soil sample points were digitized using the 'Editor Toolbar' by interpreting the soil and 

landform map. Each point was manually placed at the appropriate location and given a sample 

number. Attributes were added via the attribute table to ensure unique identification and 

linkage with provided soil chemical data. 

41. Load the soil and landform map and relevant base layers. 

42. From Arc Catalog create a new Point Shapefile 

43. Activate Editor Toolbar and start editing the soil sample point 

layer. 

44. Manually place points at sample locations based on map 

interpretation. 

45. Open the attribute table and add unique sample number 

46. Save edits and stop editing. 
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Soil Chemical data joining 

Chemical test data provided by soil expert was joined with the digitized sample point layer 

using the 'Join' tool in ArcGIS. This join was based on a common field (e.g., sample No.). The 

joined attributes (e.g., pH, Nitrogen, Phosphorus) enabled spatial analysis of soil quality across 

upazila. 

47. Add the excel or csv file of soil chemical data 

48. Open the attribute table of the soil sample points layer. 

49. Right-click the layer > Joins and Relates > Join 

 

50. Select: Join Field = Sample Number, Join Table = 

Excel or CSV file with chemical data, Join Field in Table = Matching Sample Number. 

51. Click OK to join.  

52. To make the join permanent, export the shapefile. 

 

 

DEM data processing 

SRTM DEM data at 30m resolution was downloaded and resampled to 20m using the 

'Resample' tool (Data Management Tools > Raster > Raster Processing > Resample). Each 
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upazila DEM was clipped using the 'Extract by Mask' tool, and then converted to point format 

using the 'Raster to Point' tool for further analysis. These elevation points help with terrain-

based interpretation and suitability mapping. 

53. Add the SRTM DEM (20m Resolution) 

raster file.  

54. Add the Upazila boundary shpefile and 

Query the desired Upazila  

55. Go to the Arc Toolbox > Data 

management Tools > Raster > Raster 

Processing Clip 

56. Clip the DEM layer according to Upazila boundary extent  

57. Use Conversion Tools > From Raster > Raster to Point to convert DEM to elevation 

points. 

 

Projection Change 

All shapefiles (SOP, SOL, and DEM points) were reprojected to the Bangladesh Transverse 

Mercator system (BTM, Gulshan 303) using the 'Project' tool. This ensures all datasets are 

spatially aligned and compatible with national mapping standards. 

58. Open ArcToolbox > Data 

Management Tools > Projections and 

Transformations > Project. 

59. Set: Input Dataset = Each shapefile 

(SOP, SOL, DEM Points), Output 

Coordinate System = BTM (Gulshan 

303). 

60. Run the tool separately for each 

shapefile. 
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Data upload and processing 

The final shapefiles (SOP, SOL, and DEM 

points) were compressed into three separate ZIP 

archive. File naming followed the format 

protocol specified by the Crop Zoning 

Information System (CZIS). This ZIP file was 

uploaded to the CZIS web platform, which 

automatically processes and integrates the layers 

into the central spatial database for analysis and 

visualization.  

61. Ensure the final shapefiles are: SOP (Soil 

Polygons), SOL (Soil Sample Points), DEM 

Points. 

62. Go to: http://cropzoning.gov.bd:82/preprocess. 

63. Log in using your credentials. 

64. Select Divion, District and Upazila 

65. Select DEM to SRTM 

66. Upload the respective ZIP files for automatic integration. 

67. Make sure the naming convention: xxxxxx_SOP_, xxxxxx_SOL_, xxxxxx_SRTM_, 

where xxxxxx = 6-digit Upazila Code. 

68. Click each button sequentially, from ‘Process Upazila Data’ to ‘Clear Map Cache 

Data’. 
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C. Development of Crop Zoning System and Khamari Mobile App 

1. Introduction to the GIS application 

What is GIS? 

GIS stands for Geographic Information System 

A framework for gathering, managing, and analyzing spatial and geographic data 

Combines maps, data, and technology to solve real-world problems 

What is a GIS Web Application? 

A browser-based tool that allows users to access GIS functionalities online 

Integrates maps, spatial data, and interactive tools 

Enables real-time access to geographic information from any location 

 

Core Features of a GIS Web Application 

• Interactive Map Viewer (Zoom, Pan, Layers) 

• Search and Filter Capabilities 

• Layer Management (toggle visibility, custom styles) 

• Attribute Data Display (popups, tables) 

• Geo-spatial Querying and Analysis 

• User Authentication (optional) 

Common Technologies Used 

• Frontend: HTML, CSS, JavaScript (React, Vue, or Angular) 

• Mapping Libraries: Leaflet, OpenLayers, Mapbox, or ArcGIS JS API 

• Backend: PHP, Node.js, Python, etc. 

• Databases: PostGIS, Oracle Spatial 

• Web Map Services: WMS, WFS, REST APIs 

GIS Application Workflow 

• Data Collection 

• Data Input & 

Validation 

• Visualization on 

Map 

• Spatial Analysis 

• Reporting and 

Decision Making 
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Basic Architecture of Web Application 

 

 

 

 

 

 

 

 

 

Common Architecture of Web Application 

 

 

 

 

 

 

 

 

 

 

 

Common Architecture of Web GIS Application 
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Common Architecture of Web GIS Application with Tech Stack 

System Architecture of CZIS Application 

Type: Web-based Client-Server Architecture 

Pattern: MVC (Model-View-Controller) via 

Laravel 

Deployment: Multi-Layered Monolithic 

 

 

 

 

 

Layered Architecture 

A. Presentation Layer (Client Side) 

Technologies: 

• Laravel Blade Templates (HTML, Blade) 

• CSS, Bootstrap 

• JavaScript, jQuery, Vue.js 

• OpenLayers (for map rendering and interaction) 

Functions: 

• User interface rendering 

• User input collection 

• Map display and interaction (OpenLayers) 

• AJAX calls to backend APIs 

• Vue components (optional reactive UI) 
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B. Application Layer (Backend - Laravel Framework) 

Technologies: 

• PHP (Laravel 5.7) 

• RESTful API endpoints 

• Routing, Controllers, Services, Middleware 

Functions: 

• Handles HTTP requests (via controllers) 

• Business logic (via services or directly in controllers) 

• Communicates with PostgreSQL/PostGIS database 

• Provides GeoJSON/map data to OpenLayers via APIs 

• Handles authentication, sessions, and user roles 

 

C. Data Layer (Database and GeoServer) 

1. PostgreSQL with PostGIS 

• Stores spatial and non-spatial data 

• Executes spatial queries 

• Used by Laravel via Eloquent/Query Builder and raw SQL 

2. GeoServer (v2.20.0) 

• Publishes spatial data (WMS/WFS/WCS services) 

• Reads from PostgreSQL/PostGIS (via JDBC/GeoTools) 

• Serves raster/vector layers to OpenLayers frontend 

 

Server and Networking 

A. Web Server: NGINX 

• Handles HTTPS requests and serves Laravel app 

• Reverse proxy to PHP-FPM for Laravel 

• Serves static files (JS/CSS/images) 

• Can proxy specific paths (e.g., /geoserver/) to GeoServer 

B. PHP-FPM 

• Executes Laravel application 

• Connects to PostgreSQL for data queries 

C. GeoServer (Separate VM) 

• Accessed via subdomain or path (/geoserver) 

• Interacts with database and serves map data 

 

Data Workflow 
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Major Modules of CZIS 

 

 

 

 

 

 

 

Technology Stacks of CZIS 

Technology CZIS Web 

Application 

Agri Web portal Khamari Mobile 

App (Android) 

Khamari Mobile 

App (iOS) 

Database PostgreSQL 

(version 11.10) 

with PostGIS 

extension  

PostgreSQL 

(version 11.10) 

PostgreSQL 

(version 11.10) 

PostgreSQL 

(version 11.10) 

Programming 

Language 

PHP with Laravel 

Framework 

(version 5.7) 

 

PHP with Laravel 

Framework 

(version 5.7) 

PHP with Laravel 

Framework (version 

5.7) for API service, 

Java for Android 

native languages 

PHP with Laravel 

Framework (version 

5.7) for API service, 

JavaScript for react 

native 

UI 

Development 

Laravel blade 

template with 

HTML, CSS, 

JavaScript, 

jQuery, Bootstrap, 

Vue, Openlayer 

Laravel blade 

template with 

HTML, CSS, 

JavaScript, 

jQuery, Bootstrap 

Android Native React (version 

17.0.1), React 

Native (0.64.3) 

 

Map Server GeoServer 

(version 2.20.0) 

- GeoServer (version 

2.20.0) 

GeoServer (version 

2.20.0) 

Web Server Nginx Nginx Nginx Nginx 

Server OS Ubuntu (version 

20.04) 

 

Ubuntu (version 

20.04) 

Ubuntu (version 

20.04) 

Ubuntu (version 

20.04) 

Development 

Tool 

Visual Studio 

(version 1.63.2), 

pgAdmin (version 

6.5) 

Visual Studio 

(version 1.63.2), 

pgAdmin (version 

6.5) 

Visual Studio 

(version 1.63.2), 

pgAdmin (version 

6.5), Android 

Studio (version 

2021.2.1) 

Visual Studio 

(version 1.63.2), 

pgAdmin (version 

6.5) 
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2. Development Tools and Environment Setup 

Installation of software required for crop zoning system development 

How to install: 1_xampp-windows-x64-7.4.28-0-VC15-installer 

Step 1: Click on the software link 

Step 2: Click  Next > 

Step 3: Put Tick mark in Apache, MySQL, PHP, phpMyAdmin 

Click  Next > 
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Step 4: Select a folder (except C drive) and name the folder 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click  Next > 
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Step 6: Language ‘English’ and click Next > 

Step 7: Click Next > and wait for some moment and click Finish 
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Step 8: Click on Apache Start button 

Step 9: 

 

Step 10: Apache need to be running in backend to work further 
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How to install: 2_pgadmin4-9.2-x64 

Step 1: 

 

Clink on the software link, select for me only and then click Next  > 

 

Step 2: Select ‘I accept to the agreement’ and click Next > 

 

 
Step 3: Click Next then Install 
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How to install: 3_Composer-Setup 

Step 1: Click on the software link and select for installation 

 

 

Step 2: Select php browser and install and finish 
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How to install: 4_(optional)_postgresql-17.5-1-windows-x64 

Step 1: Click on the software link and select for installation 

 Click Next> 

Step 2: Select installation directory and Click Next> 
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Step 3: Select component and Click Next> 

Step 4: Select data directory and Click Next> 

Step 5: Provide a password and remember password for further use 
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Step 6: Select the port number and remember the port number the server should listen on 

 

Click Next> 

Step 7: Select the locale to be used by the new database duster and Click Next> 

Step 8: Click Next> and Finish 

Step 9: Install Stack builder 4.2.2 

Step 10: Select applications- Spatial Extensions- PostGIS 
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Step 11: 

 
 

Click Next> 

Step 12: Select download directory and Click Next> 

Step 13: 

Click Next> 
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Step 14: 

Choose component and click Next > 

Step 15: Choose install location and click Next > 

Step 16: Click close and click finish. 
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3. Application of Development Tools 

Step 1: Open XAMPP softwate and start Apache 

Step 2: Open folder of XAMPP from downloaded directory 

Step 3: Open htdocs folder and create a folder (for example: Training) 

Step 4: Create a index.php file and open with Visual Studio Code 

Step 5: Search ‘Localhost; in browser 

Step 6: Type localhost/training (file name) 

 

 

Step 7: Output will be displayed according to input in VSCode file. 

Step 8:  
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4. Laravel Overview 

What is Laravel 

Laravel is a free, open-source PHP-based web framework for building web applications. It's 

designed to simplify the development process, offering features like a clean syntax, 

dependency injection, database abstraction, and more. Laravel is particularly known for its 

elegant syntax and its focus on providing a great developer experience.  

✓ A PHP web application framework. 

✓ Follows the MVC (Model-View-Controller) architectural pattern. 

✓ Designed for elegant syntax and developer productivity. 

 

 

 

 

 

 

 

 

 

Key Features 

• Routing System: Clean and expressive URL routing. 

• Eloquent ORM: Powerful and intuitive Object Relational Model. 

• Blade Templating Engine: Simple and reusable templates with control structures. 

• Artisan CLI: Built-in command-line tool for automation. 

• Security: CSRF protection, hashing, and authentication mechanisms. 

• Database Migrations & Seeders: Version-controlled DB schema management. 

• Queues & Jobs: Background processing using queues. 

• Testing Support: Integrated testing tools for unit and feature tests. 

 

 

https://www.php.net/
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Laravel 8.x folder architecture 

 

 

Starting a Laravel Application 

Run this command to create a Laravel project (example uses Laravel 8): 

composer create-project --prefer-dist laravel/laravel:^8.0 myLaravelApp 

Run the Laravel Development Server: 

php artisan serve 

Configure the .env file in your project folder:  

CONNECTION=postgres 

HOST=localhost 

DB_PORT=3306 

DB_DATABASE=my_laravel_db 

DB_USERNAME=root 

DB_PASSWORD= 

Create Model: 

php artisan make:model Employee 

Create Controller: 

php artisan make:controller EmployeeController 

Define Route 

In routes/web.php: 

use App\Http\Controllers\EmployeeController; 

Route::get('/employees',[EmployeeController::class, 

'index'])>name('employees.index'); 
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Step 1: Open Visual Studio Code 

Click enter 

Step 2: 

Copy the link: http://127.0.0.1:8000/ and paste in browser 

 

http://127.0.0.1:8000/
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Step 3: 

Open Lavarel  

Step 4: 

In vs code, open web.php file 
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Step 5: 

Open welcome.blade.php file  

 

5. PostgreSQL (PostGIS) Overview 

 

Introduction to PostgreSQL 

Core Components of RDBMS: 

✓ SQL (Structured Query Language): Standard language for querying and managing 

databases. 

✓ Schema: Defines the structure of tables, relationships, and constraints in a database. 

✓ Indexing: Helps speed up data retrieval by creating an index on columns commonly 

used in queries. 

✓ Transaction Management: Ensures database operations are completed successfully with 

ACID (Atomicity, Consistency, Isolation, Durability) properties. 

Advantages of RDBMS: 

✓ Data Integrity: Enforces accuracy and consistency through primary and foreign keys, 

constraints, and ACID compliance. 

✓ Data Security: User roles and permissions protect sensitive data. 

✓ Data Relationships: Easy to define and enforce relationships between different data 

points. 

✓ Scalability: Supports large amounts of data and multiple users concurrently. 
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RDBMS Structure 

 

 

 

 

 

 

 

 

 

 

 

What is PostgreSQL? 

✓ PostgreSQL, often referred to as Postgres, is an open-source relational database 

management system (RDBMS) known for its robustness, flexibility, and advanced 

features. 

✓ Initially developed at the University of California, Berkeley, it has evolved into one of 

the most widely used RDBMS systems globally, especially popular for complex data 

processing. 

 

Uses and Applications 

✓ PostgreSQL is suitable for applications in finance, geospatial data, data warehousing, 

and more. 

✓ Popular in web development, analytics, and data science due to its support for various 

data types and powerful querying capabilities. 

 

Key Features and Advantages 

✓ ACID Compliance: Ensures data integrity and reliability through atomicity, 

consistency, isolation, and durability. 

✓ Open Source: Free to use and continuously improved by a large community. 

✓ Extensibility: Allows users to add custom functions, data types, and languages. 
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✓ Advanced Data Types: Includes support for JSON, arrays, XML, and geospatial data 

through the Post-GIS extension. 

✓ Concurrency Control: Uses MVCC (Multi-version Concurrency Control) to handle 

multiple transactions effectively.  

✓ High Performance: Offers indexing, partitioning, and other tools to optimize 

performance. 

 

PostgreSQL Architecture 

 

 

 

 

 

 

 

 

 

Data Types in PostgreSQL 

✓ Numeric: INTEGER, SMALLINT, BIGINT, NUMERIC, DECIMAL, REAL, 

DOUBLE PRECISION. 

✓ Text: VARCHAR, CHAR, CHARACTER VARYING, TEXT. 

✓ Date/Time: DATE, TIME, TIMESTAMP, INTERVAL. 

✓ Boolean: TRUE or FALSE. 

✓ Array: Multi-dimensional arrays supported for various data types. 

✓ JSON: Supports JSON and JSONB for semi-structured data storage. 

Basic SQL Operations 

✓ CREATE DATABASE my_database; 

✓ psql -d my_database; 

✓ CREATE TABLE employees ( 

    id SERIAL PRIMARY KEY, 

    name VARCHAR(100), 

    age INTEGER, 

    department VARCHAR(50) 

); 

✓ INSERT INTO employees (name, age, department) VALUES ('John Doe', 30, 

'Sales'); 

✓ SELECT * FROM employees WHERE department = 'Sales'; 

✓ UPDATE employees SET age = 31 WHERE name = 'John Doe'; 

✓ DELETE FROM employees WHERE name = 'John Doe'; 
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Advanced Features 

✓ Views: Stored queries that act as virtual tables. 

sql- 

CREATE VIEW sales_view AS SELECT name, department FROM employees WHERE 

department = 'Sales'; 

✓ Stored Procedures and Functions: Custom functions and procedures for reusability. 

✓ Triggers: Automate actions before/after specific operations on a table. 

Step 1: Open pgAdmin 4 

 

Step 2: Click on ‘Servers’ 
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Step 3: Select the server and give password (the password was saved during installation) 

Step 4: Select server location> Click on the right button of mouse and select register and 

then server 

Step 5: Fill up general and connection options 

Step 6: 

Server will be added 
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Step 7: 

Database need to be added 

Step 8: 

Select databases> Click on the right button of mouse and select create and then add 

database  
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Step 9: 

Database is added 

Step 10: 

Table of information need to be added 
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Step 11: 

 

Step 12: Name should be lowercase and underscore is used if needed break. 

Database all info will be in lowercase. 

Step 13: 
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Step 14: 

 

Step 15: 

To see table properties click on the right button of mouse and select properties  
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Step 16: 

To add info in table, click on the right button of mouse and select script and then 

select script  

Step 17: 

Script is displayed 
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Step 18: 

 

Step 19: 

Execute query tool to data output 
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6. GeoServer Overview 

What is GeoServer 

• GeoServer is an open-source server for sharing geospatial data. 

• Developed in Java and maintained by the Open Source Geospatial Foundation 

(OSGeo). 

• Enables interoperability by publishing data using open standards. 

 

Supported Data Formats 

• Vector: 

• Shapefile 

• GeoJSON 

• GML 

• PostGIS 

• Oracle Spatial 

• Raster: 

• GeoTIFF 

• JPEG, PNG 

• ImageMosaic 

 

OGC Standards 

• WMS (Web Map Service): Render maps as images. 

• WFS (Web Feature Service): Access vector features. 

• WCS (Web Coverage Service): Serve raster data. 

• WMTS (Web Map Tile Service): Pre-rendered tiles for fast access. 

 

Key Features 

• Supports OGC standards: WMS, WFS, WCS, WMTS. 

• Provides web-based administration interface. 

• Connects to spatial databases: PostGIS, Oracle Spatial, etc. 

• Supports vector and raster data formats (Shapefile, GeoTIFF, etc.) 

OGC Standards 

• WMS (Web Map Service): Render maps as images. 

• WFS (Web Feature Service): Access vector features. 

• WCS (Web Coverage Service): Serve raster data. 

• WMTS (Web Map Tile Service): Pre-rendered tiles for fast access. 
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Step 1: geoserver admin panel: 

http://geo.iwmbd.com:8095/geoserver/web/ 

Username: as provided  

Pass: as provided 

Step 2: 

 

Step 3: 

 

http://geo.iwmbd.com:8095/geoserver/web/
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Step 4: 

 

Step 5: 

To publish new layer workspace, store and layers  
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Step 6: 

 

Step 7: 

Need to select Compute from data and Compute from native bounds 

 

Step 8: To display Layer, we need to go through layer preview 
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Step 9: To see a map layer:  

Prepare a map.html file in a folder and open with visual studio code 

Open the map.html file with Crome browser 

In visual studio code file place the coding and show output in the local host 
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Step 10: 

 

Step 11: To change color / style  
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7. Overview of Spatial Extensions in PostgreSQL (PostGIS) 

What is PostGIS? 

✓ PostGIS is a spatial database extender for PostgreSQL that allows geographic objects 

to be stored and queried. 

✓ It transforms PostgreSQL into a powerful spatial database that supports location 

queries and spatial data analytics. 

Why Use PostGIS? 

✓ Enables storage, manipulation, and analysis of geographic data directly within 

PostgreSQL. 

✓ Supports a wide range of spatial data operations, essential for applications in GIS 

(Geographic Information Systems), mapping, urban planning, and more. 

 

 

 

 

 

 

 

 

 

 

 

 

Key Features of PostGIS 

✓ Support for Geometric and Geographic Data: Allows handling of both planar (2D) 

and spherical (3D) geometries. 

✓ Spatial Functions: Hundreds of functions to perform complex spatial analyses, such 

as distance, area calculation, and spatial joins. 

✓ Spatial Indexing: Optimized for querying large datasets using R-tree-based GiST 

indexing. 

✓ Compatibility: Works with many GIS applications and standards (e.g., GeoJSON, 

GeoServer, QGIS). 
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PostGIS Data Types 

Geometry and Geography Data Types 

✓ Geometry: Represents planar geometries, useful for Cartesian calculations (e.g., 

distances in meters). 

✓ Geography: Represents spherical data, better suited for large-scale geographic 

calculations (e.g., distances in kilometers). 

Common Spatial Data Types 

✓ Point: Represents a single location (e.g., a city). 

✓ Line: Represents a sequence of points (e.g., a river or road). 

✓ Polygon: Represents an area (e.g., a lake or city boundary). 

✓ MultiPoint, Multi-Line, Multi-Polygon: Collections of points, lines, or polygons. 

 

Spatial Reference Systems (SRS) and Coordinate Systems 

Spatial Reference System (SRS) 

✓ Defines how spatial data aligns with real-world coordinates. 

✓ Common SRS examples include WGS 84 (EPSG:4326), used for latitude/longitude. 

Coordinate Transformation 

✓ PostGIS supports transforming geometries between different coordinate systems. 

sql 

SELECT ST_Transform(geom, 3857) FROM my_table; -- Transforms to Web Mercator 

 

 

Working with Spatial Data in PostGIS 

✓ CREATE EXTENSION postgis; 

✓ CREATE TABLE cities ( 

    id SERIAL PRIMARY KEY, 

    name VARCHAR(100), 

    location GEOGRAPHY(Point, 4326) 

); 

✓ INSERT INTO cities (name, location) VALUES  

 ('New York', ST_SetSRID(ST_MakePoint(-74.006, 40.7128), 4326)); 

✓ SELECT name FROM cities 

 WHERE ST_DWithin(location, ST_MakePoint(-74.006, 

40.7128)::geography, 10000); -- within 10 km 
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Indexing Spatial Data 

GiST Indexing 

✓ Spatial Index: Use GiST (Generalized Search Tree) indexing to optimize spatial 

queries. 

sql 

CREATE INDEX cities_location_idx ON cities USING GIST(location); 

✓ Effect: Drastically improves performance for queries involving spatial functions like  

 ST_Intersects and ST_DWithin. 

 

Hands-On Examples 

 

 

Example 1: Distance Calculation 

✓ Calculate the distance between two cities. 

sql 

SELECT ST_Distance( 

  ST_MakePoint(-74.006, 40.7128)::geography, 

  ST_MakePoint(-118.2437, 34.0522)::geography 

) AS distance_km; 

 

 

Example 2: Finding Intersecting Polygons 

✓ Identify polygons representing land use that intersect with a specific area. 

✓  

sql 

SELECT land_use.id, land_use.type 

FROM land_use, protected_areas 

WHERE ST_Intersects(land_use.geom, protected_areas.geom); 

 

Overview of Geospatial Functions and Operators in PostgreSQL (PostGIS) 

Introduction to Geospatial Functions in PostGIS 

PostGIS is an extension of PostgreSQL that supports geographic objects, allowing users to 

store and query geospatial data directly in the database. Geospatial functions in PostGIS cover 

a wide array of operations, from basic geometry creation to complex spatial analytics, useful 

in GIS (Geographic Information Systems), mapping, and location-based services. 

Benefits of Using PostGIS Geospatial Functions 

✓ Perform complex spatial queries and analyses within PostgreSQL. 

✓ Efficiently manage and manipulate geospatial data. 

✓ Build applications requiring location-based analysis, proximity queries, or mapping 

capabilities. 
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Spatial Data Types in PostGIS 

Core Data Types 

✓ Geometry: Represents planar geometries (2D). 

✓ Geography: For data on a spherical model, supporting large distances (e.g., global 

datasets). 

Common Geometry Types 

✓ Point: A single location (latitude/longitude). 

✓ Line: A sequence of points (e.g., a road). 

✓ Polygon: An enclosed area (e.g., a park boundary). 

✓ MultiPoint, MultiLine, MultiPolygon: Collections of points, lines, or polygons. 

 

Basic Geospatial Functions 

Geometry Creation 

✓ ST_MakePoint(x, y): Creates a point geometry. 

sql 

SELECT ST_MakePoint(-71.060316, 48.432044); 

✓ ST_MakeLine(array of points): Creates a line geometry. 

✓ ST_MakePolygon(line): Creates a polygon geometry from a closed line. 

Setting and Transforming Spatial Reference Systems (SRS) 

✓ ST_SetSRID(geometry, srid): Assigns an SRS to a geometry. 

sql 

SELECT ST_SetSRID(ST_MakePoint(-71.060316, 48.432044), 4326); 

✓ ST_Transform(geometry, srid): Converts a geometry from one SRS to another. 

 

Spatial Relationship Functions 

Spatial relationships help identify the relative positions of spatial objects. 

✓ ST_Intersects(geomA, geomB): Checks if two geometries intersect. 

✓ ST_Contains(geomA, geomB): Returns true if geomA fully contains geomB. 

✓ ST_Within(geomA, geomB): Checks if geomA is within geomB. 

✓ ST_Touches(geomA, geomB): Returns true if the geometries have at least one point in 

common, but their interiors do not intersect. 

Example 

sql 

SELECT name FROM parks 

WHERE ST_Contains(parks.geom, ST_MakePoint(-71.060316, 48.432044)); 
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Geometry Processing and Analysis Functions 

PostGIS includes functions to analyze and modify geometries, such as: 

✓ ST_Buffer(geometry, distance): Creates a buffer around a geometry. 

sql 

SELECT ST_Buffer(ST_MakePoint(-71.060316, 48.432044)::geography, 1000); 

✓ ST_Intersection(geomA, geomB): Returns the intersection of two geometries. 

✓ ST_Difference(geomA, geomB): Returns the parts of geomA that do not overlap with 

geomB. 

  

  

Example 

sql 

SELECT ST_Intersection(a.geom, b.geom) 

FROM table_a a, table_b b 

WHERE ST_Intersects(a.geom, b.geom); 

 

Spatial Aggregation and Measurements 

Distance and Measurement Functions 

✓ ST_Distance(geomA, geomB): Calculates the minimum distance between two 

geometries. 

✓ ST_Length(geometry): Calculates the length of a Line. 

✓ ST_Area(geometry): Calculates the area of a Polygon. 

 

Example 

sql 

SELECT ST_Distance( 

  ST_MakePoint(-71.060316, 48.432044)::geography, 

  ST_MakePoint(-73.935242, 40.730610)::geography 

) AS distance_in_meters; 

 

Aggregating Spatial Data 

✓ ST_Union(geometry set): Merges multiple geometries into one. 

sql 

SELECT ST_Union(geom) FROM rivers; 

 

Practical Examples and Use Cases 

 

Example 1: Finding Nearby Points 

✓ Query to find locations within a 5-kilometer radius of a point. 

sql 

SELECT name 

FROM cities 

WHERE ST_DWithin( 

  geom, 

  ST_SetSRID(ST_MakePoint(-71.060316, 48.432044), 4326), 

  5000 

); 
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Example 2: Calculate the Area of a Polygon 

✓ Useful in applications like calculating the area of a land parcel. 

sql 

SELECT name, ST_Area(geom) AS area_sq_meters 

FROM parcels; 

 

ER Diagram of major modules 

Crop Module 

 

 

 

 

 

 

 

 

 

Core Entry Module of Upazila Data 
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Fertilizer Module 

 

 

 

 

 

 

 

 

 

 

 

 

Crop Suitability Module 
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Agro Climatic Module 

 

 

 

 

 

 

 

 

 

 

 

Fertilizer Module 
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pgAdmin and Postgresql Activity  

 

Step 1: Open pgAdmin software (Management tools for PostgreSQL 

Step 2: Click on ‘Servers’ and add server to connect with postGIS 

 

Step 3: Create New Database from this dialog box: 
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Step 4:  add extention like postgis from Extention option 
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Step 5: PostGIS Shapefile Export/ Import Manager 

 

Open shp2pgsql-gui.exe file  

Normally this file is located at : 

{postgresql_setup_directory}\{version_number}\bin\postgisgui\ 

 

Step 6: Click on the View connection details   
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Step 7: Fill the table content, username is the server name added in the server in pgAdmin, password 

was saved during preparing the database in pgAdmin 

Click Ok to connect to the server. 

 

 

 

 Connection succeeded. 
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Step 6: Click on Add File 

Step 7: 

Select shape file and open 

Step 8: 

Connection succeeded 

Step 9: Fill the SRID 3106 and other options as you need 
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Step 11: 

Then Import 

Step 12: 

Shapefile import completed 
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8. Khamari Mobile App Overview 

 

Android Application Lifecycle 

 

• Definition: The Android application lifecycle describes the sequence of states an app 

goes through, from launch to shutdown, driven by user interactions and system 

events. 

• Importance: Managing lifecycle states is crucial for optimal memory usage, smooth 

user experience, and app performance. 
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Lifecycle Phases 

✓ Launch (Activity Creation): 

✓ onCreate(): Initialization of essential components. 

✓ onStart(): Preparing the app to become visible. 

✓ Active (Running State): 

✓ onResume(): App becomes interactive; UI is fully visible. 

 

 

Android Activities 

Definition: An Activity represents a single screen in an Android app, serving as the entry 

point for user interactions with an app. 

Purpose: Activities are essential for managing the app’s user interface and handling user 

inputs. 

Lifecycle Management: Each Activity goes through a lifecycle of states (created, started, 

resumed, paused, stopped, destroyed) which affects its visibility and interaction capability.  

 

These are the activity lifecycle callbacks we’ll be taking a look at:  

1. onCreate 

2. onStart 

3. onResume 

4. onSaveInstanceState 

5. onPause 

6. onStop 

7. onDestroy 

8. onRestoreInstanceState 
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Android Fragments 

 

• Definition: A Fragment is a reusable, modular section of an Activity that has its own 

lifecycle, UI, and can be added or removed dynamically. 

• Purpose: Fragments enable flexible UI designs that adapt to different screen sizes, 

especially on tablets and multi-pane layouts. 

Key Benefits: 

• Modularity: Enables code reuse across multiple activities. 

• Dynamic UI: Add, replace, or remove fragments at runtime to provide a responsive 

user experience. 

 

 

Example Use Case: 

• Master-Detail Layout: On tablets, show a list on one fragment and details on 

another. 

Types of Android Fragments 

1. Single Fragment: Display only one single view on the device screen. This type of 

fragment in android is mostly used for mobile phones. 

2. List Fragment: This Fragment is used to display a list-view from which the user can 

select the desired sub-activity. The menu drawer of apps like Gmail is the best 

example of this kind of android fragment. 

3. Fragment Transaction: This kind of fragments in android supports the transition 

from one fragment in android to another at run time. Users can switch between 

multiple fragments like switching tabs. 
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Fragment Lifecycle and Management 

 

 

Android Intents 

 

• Definition: An Intent is a messaging object used to request an action from another 

app component, allowing communication within and between apps. 

• Types of Intents: 

• Explicit Intent: Directly specifies the target component (e.g., start another activity 

within the same app). 

• Implicit Intent: Declares an action and lets the system determine which app can 

handle it (e.g., sharing a file or opening a URL). 

 

Common Use Cases: 

• Activity Navigation: Start a new screen in the same app. 

• Data Sharing: Send data to other apps, such as a photo or text. 
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9. BCC Cloud Console Overview 

 

About BCC Cloud 

✓ Hosted at: https://ndc.bcc.gov.bd 

✓ National Data Center by Bangladesh Government 

✓ Provides Elastic Compute Service (ECS) and other cloud solutions 

✓ Secure, scalable, and locally hosted infrastructure 

 

Deployment Summary 

✓ 5 ECS instances across different roles 

✓ Application servers behind load balancer 

✓ Dedicated PostgreSQL DB 

✓ High-memory GeoServer setup 

✓ Staging ECS with developer tools 

 

Application Server Overview 

✓ Hosted at: https://ndc.bcc.gov.bd 

✓ National Data Center by Bangladesh Government 

✓ Provides Elastic Compute Service (ECS) and other cloud solutions 

✓ Secure, scalable, and locally hosted infrastructure 

 

 

 

 

 

 

 

 

 

 

https://ndc.bcc.gov.bd/
https://ndc.bcc.gov.bd/
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Server System Architecture Diagram 
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Load Balancing Strategy 

✓ Elastic Load Balancer distributes traffic 

✓ Ensures high availability & fault tolerance 

✓ Health checks monitor instance status 

✓ Horizontal scaling-ready  

 

 

Database Server (PostgreSQL) 

✓ 1 ECS: 16 Cores, 32 GB RAM, Ubuntu 

✓ PostgreSQL configured for high performance 

✓ Weekly backups 

✓ Only accessible from App servers (firewalled) 

 

 

 

GeoServer Architecture 

✓ 1 ECS: 16 Cores, 64 GB RAM, Ubuntu 

✓ Running 3 GeoServer instances 

✓ Uses PostgreSQL/PostGIS for spatial data 

✓ Serves WMS/WFS/Geo 

 

Staging Server Configuration 

✓ 1 ECS: 4 Cores, 8 GB RAM, Windows OS 

✓ Tools Installed: 

✓ pgAdmin for DB management 

✓ MobaXterm for SSH/terminal 

✓ FTP server for file transfers 

✓ Isolated for UAT & internal testing 
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BCC Cloud Console Panel Access Process 

Step 1: Setup BCC provided VPN client SecoClient as instructed by their manual. 

Step 2: Brows the URL - https://console.egovcloud.gov.bd 

 

 

Step 3: Login to the panel with User Id and Password. 

Logged in Dashboard of BCC Console Panel 

 

 

 

 

 

https://console.egovcloud.gov.bd/
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Current ECS list  

 

 

Single ECS Details 

 

 

D. Concluding Remarks 

Training on crop zoning system will help to continue, update and maintain crop zoning activity 

after the completion of project. Application of crop zoning system in agriculture will not only 

promote sustainable agriculture but also ensure food and nutrition security maintaining good 

soil health. This training manual will serve as a guideline of crop zoning system development. 


